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GoldSync Problems - A
White Paper ( PartI)

by

David Lee

Data synchronization is an issue for every CRM
program that supports the feature. Some do
it better than others, but none do it perfectly.
Nevertheless, it is such a valuable feature that
all of the major systems continue to try. Even
in this day of web access, it is often necessary
to have a local copy of your database.

This 3-part series is a discussion of problems that you might encounter with GoldMine
synchronization, and how you might correct them. It is not a discussion of how to
use all of the features of GoldSync.

The first installment discusses how GoldMine synchronization works, its advantages
and disadvantages, and how you know if you might have a problem.

The second installment discusses the ways in which sync problems occur. You will
see that many “synchronization” problems are really database or data problems which
are manifested by the synchronization process.

The third installment discusses how to correct your GoldMine synchronization problems.
How does GoldMine sync work compared to other systems?

The major CRM systems have each found its own way to synchronize data. None of
them are perfect, and all of them wiill lose data in some situations. Despite
this, the value of being able to synchronize remote systems and work offline is so
great that virtually every major CRM system provides this option (including web-
based ASP systems). You would like to find a system that loses data rarely, that
allows you to find out whether or not you have lost data, and that gives you a good
way to recover the data.

Some systems, such as SalesLogix, dynamically build transfer sets as you enter data.
This is an effective approach when you have a very small number of synchers. However
it is very slow if you have large numbers or if there are problems which require you
to re-build your transfer sets.

Other systems, such as Microsoft CRM, track changes and force an update when you
dock and undock from the system. This gives you little or no ability to correct sync
errors or re-set your sync. In Microsoft's case, it also lacks sophisticated conflict
resolution rules (what do you do if two people updated the same field, and then you
Sync the systems?

( Continued on Page 2 )
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Editor: DJ Hunt

Although I try to edit these
articles for content and accuracy,
I cannot always guarantee their
content is accurate. Should you
use anything from this
newsletter, you do so at your
own risk. All information contained herein is not intended
as specific advice, but as a general point of discussion.

All articles are freely contributed from their author. In many
cases the authors have had a technical expert, in the area
of the document, prereview the document for content and
accuracy.

All major article contributors will have a business card
displayed on the last page of this document. You are
encouraged to clip the business card and save it. Do not
contact the author directly unless, at the end of their article,
they have made a declaration of sorts that states that you
may contact them personally.

All questions, and future articles should be submitted to:
DJ.Hunt@DJ-Hunt.com

If you are including screenshots, they should be no wider
than 3.57” US. Their Print resolution should be 300 dpi,
and they should be in jpg format.

Major contributors are asked to also submit a 1” US wide
portrait photo. The Print resolution should be 300 dpi, and
the format should also be a jpg format.

We accept all articles, however, the editor reserves the
right to determine which articles are included and in which
issues they are included.

I am your editor:

DJ Hunt

Computerese

152 Pratt Road

Fitchburg, MA 01420

USA

(978)342-3333

DJ].Hunt@DJ-Hunt.com
www.DJ-Hunt.com

GoldMine is a registered trademark of FrontRange Solutions.
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( Continued from Page 1)

GoldMine builds the transfer sets when you ask for them
or it pre-builds them on a schedule. The building process
is resource-intensive, but it can support a very large number
of users without degrading system performance. GoldMine
also has a sophisticated conflict resolution capability (the
most recent change “wins” with proper adjustments made
for users in different time zones) In addition, GoldMine
creates transaction logs (Tlogs) to track who made changes,
when they were made, what was changed, and when the
change was synchronized.

This ability to create transfer sets at any time gives GoldMine
great flexibility and scalability compared to other systems.
It also creates many vulnerabilities as discussed in this
white paper.
Why is it better? Why is it worse?

e Advantages of GoldSync

o Scalable to large numbers of users

o Supports many
methodologies

topologies and

o Very flexible in determining what will and
will not sync

o 1-button sync feature reduces users’ ability
to introduce errors

o Easy (compared to other systems) to run
a “catch up” sync when there are problems

o Good conflict resolution algorithm
o Supports territory realignment

o Allows single record synchronization (for
example, you can synch a single record to
quickly transfer an account to another
person)

o Allows lateral synchronization (synchro-
nization between users as well as
synchronization with a master database):
This adds great flexibility and power

e Disadvantages of GoldSync
o Difficult to set up
o Users can introduce errors
o Difficult to diagnose errors (this is common
to most synchronization algorithms, not

just GoldMine)
( Continued on Page 3 )



( Continued from Page 2 )

o Transaction logs add significant complexity
to resolving certain classes of problems.

o Conflict resolution is not perfect. There is
no ability to configure a rule, for example,
that a manager’s changes will override a
sales rep’s changes.

o Does not have the concept of “inherited
rights,” in which a manager can elect to
receive any data that his subordinate can
receive during sync.

o Allows lateral synchronization (synchro-
nization between users as well as
synchronization with a master database):
This provides additional opportunities for
user errors

How do I detect sync problems?

One of the problems with synchronization is that it is often
difficult to detect problems. How do you know that you
did not receive a particular transaction or update? You
may want to run a monthly report (using a reporting tool,
a SQL query, or other method) to compare summary data
from all GoldMine systems. If the totals do not balance,
this might indicate sync problems.

e Use the GoldMine Statistical Analysis to compare
summary data between different GoldMine
databases.

e SQL queries, sync logs (if activated), and email
alerting tools can help determine if there are
potential problems. For example, you can
develop a series of SQL queries to let you
compare summary data between GoldMine
databases.

e Also, Sync Spy (Tools|Sync Spy) can tell you
when and by whom records were last modified
right down to the FIELD level.

e Observation: Users report missing or
inconsistent data. In practice, this is by far the
most common way that sync problems are
discovered.

About the author

David Lee is a recognized expert in CRM data
synchronization, and has configured synchronization for
hundreds of GoldMine (and other) CRM solutions.

His company, VMI, has worked in over 1,000 CRM
implementations since 1985. Almost half of these use the
synchronization feature. VMI has actually hosted
synchronization for more than 2,000 users over the last 5

years. These clients synchronize data directly to VMI
servers. VMI also supports synchronization for many others
through remote access to their own servers. In addition,
VMI has used synchronization internally since 1993. This
gives them more real-world synchronization experience than
any other organization (including FrontRange itself).

Mr. Lee has desighed
dozens of tools and
processes to analyze and
correct synchronization
problems, including
SyncRx (whose logic was
later incorporated into the
GoldMine system itself).

Editorial Note:

This ends Part I of this 3 part

series. Be sure to continue on
with Part II in the next issue of
The GoldMine Advisor, and I
hope to have an article on Davids
new product, GoldNet.

Isolating the Problem is Half the
Solution

by
Mrs. DJ

CA (Computer Addicts)

There are many symptoms of a computer addict, but these
are the most common:

1. You leave a party, and you want to find your partner,
you have to look at the back of their head to
recognize them.

2. Whendinner is at 6:00pm, and you wake up in the
dark with your face in the peas, and the other plate
hasn’t been touched.

3. You are startled at 3:00am because they jump up
and vyell, “I just figured it out”, and run to the
computer.

4. When you are going to work, and they haven't
gone to bed yet.

5. When you have to tell them you are going out
Monday evening, so you will have half a chance of
making your Tuesday evening appointment. I think
they are clock challenged.

6. They are so engrossed in work, they give the
grandchildren $20.00 each to stop pestering them,
and then blame you for taking money out of their
wallet.

7. They get tears in their eyes when they get a
lightning storm. SLEDGEéz HAMMERS

&N B
For those spouses that have seen
all these symptoms, there is help.

Don’t waste 1 more minute. Go to =

THE BIGGER
Barnes & Noble and get --------- > THE BETTER

By
Mo, ..
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GoldMine MAPI Made 4,
Possible!

by
Kevin Basso

Attach Plus enables Goldmine users to simplify the process
to create, secure and manage files sent as e-mail
attachments.

As a quick snapshot, Attach Plus is an add-on application
that allows users to work with Goldmine e-mail attachments
in a natural, and highly effective manner. It also works
with six different e-mail clients including Outlook, but we'll
focus on Goldmine here. Read on for the details!

Ever been frustrated with training users on the workflow
of properly attaching documents to Goldmine e-mail
messages? Four years ago, Kevin Day, a partner at Trumpet,
Inc. and founder of Attach Plus, hit his limit. I had just
finished a 15 minute session reminding a user that they
need to copy their attachment to a place on the network
before attaching it to a Goldmine e-mail - I realized that I
had already trained this particular user three times on the
process, and that there had to be a better way.”

About that same time, Day’s firm began working with a
document management system that required a MAPI
compatible e-mail application in order to send documents.
“That, coupled with the additional frustration of trying to
train users to encrypt their e-mail attachments (our clients
work with documents that contain social security numbers,
account numbers and other personal information) was really
the genesis of Attach Plus.” Day realized that these three
frustrations were actually a unique opportunity to develop
an application that could significantly improve his clients’
workflow.

Goldmine MAPI attachments

1 Word Document - File->Send To

2 Attachment Formatting - Attach Plus
3 Goldmine E-mail with attachment

AttachPlys”
9

!
Sensitlve document?... Send it securelyl

Blie Edit Yew Insert
& Cpen...  CwHO
Close

Flsave  cuis 1
Seve fs.. 2 Goldmine File->Send To Integration
&b Privk...  ChitP
Send 1o [ I@ afl Reciplent {25 #ltachmentds
| % R -
r— Edit E-mail
I Attach Plus o) = [} L2
> send  Queve Saveas v | Atch Sign:
daft fles  Digke

2d o David Milner

Send using filename:

R8[e »

To Do List

0 Cun
T PDF
ZD2iP Fie

T Restiicted PDF

Subject |To Do List (Secured by Attach Plus) pdf att

sl = B 2

Inchede pages: e
& al

" Pages: ,7
g ‘M Cancel
Sy

|pear David

Attached are the items we have discussed.
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Goldmine goes MAPI with Attach Plus

Attach Plus enables Goldmine users to leverage the File-
>Send To (MAPI) command within Microsoft Office and
other commonly used applications, plus adds a number of
outstanding security and efficiency features never before
offered for Goldmine.

Messaging Application Programming Interface ( MAPI )
is a system built into Microsoft Windows and other MAPI
compliant applications that enables software applications
such as Microsoft Word to communicate with users’ default
e-mail program. When MAPI is enabled, users can quickly
send files from within the software application to their e-
mail application using the File->"Send To"” feature from
the main menu. See the three-step diagram.

Attach Plus also enables users to convert files to PDF or
ZIP files and add password protection to sensitive files
they attach — anyone can follow this easy-to-use
workflow process!

Attach Plus saves Goldmine outbound e-mail
attachments

Attach Plus also provides Goldmine users the proper
archiving of outbound e-mail attachments by automatically

|y Attach Plus Settings

General | Updates | Licensing | File-Attach | PDF Options ~ Goldmine l

v Use permanent archive for attachments
Archive folder:

|b¢:'\goldmine\M ailbox\Outbound Attacht EI

" Month then user
{+ User then month

=0 J0HN
) 2003-05
() 2003-06
) 2003-07
+-2) MARY

0K | Cancel | I

creating an outbound e-mail folder from the \goldmine
\mailbox directory. Now you can reference your Goldmine
“Sent” e-mail attachments without worrying they have been
discarded.

Robust password protection for sensitive docu-
ments sent via e-mail

Attach Plus gives users the option to password protect
files each time they attach files to e-mails. This makes
securing sensitive attachments sent via e-mail part of a
company wide effort to protect client privacy on the
Internet. Attach Plus encrypts and attaches eight times
faster than the full version of Adobe Acrobat. Attach Plus
secures your Goldmine e-mail attachments using 128-bit
encrypted PDF or ZIP files as a secure container.

( Continued on Page 5 )
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(Y Attach Plus

Attach 1 file to
(% Existing E-Mail " New E-Mal

[=] Trust Financials
[=]To Do List (Secured by Attach Plus) pdf attached

Select file format: Send using filename:

2P Fie
. Restricted PDF

Cancel

Attach Plus improves Goldmine e-mail workflow

Attach Plus provides options to attach files to any e-mail in
progress or a new e-mail you create on the fly.

Create a document, then choose “File >Send To"” to attach
the document to an e-mail without being required to save
the file first.

Attach Plus is a privately held company located in
Tempe, AZ. For more information, please visit

www.attachplus.com

GoldMine MAPI Made Possible!

Fun with the
Lookup.ini

by
DJ Hunt

Someone in the newsgroup
asked for a mask for a Social
Security Number. I had :
developed a similar mask many years ago using the
Lookup.ini. I thought that I would revisit it here for
everyone to use.

Let’s start with a user defined field uSSN, C, 11, and we
will assume that some endusers will enter the Social Security
Number properly, while the lazier ones will just enter the
number. By the way, a properly formated Social Security
Number would look something like this: 025-23-1234.

Our goal then would be to have the Social Security Number
look like the one here, regardless of how the enduser
entered it into the field. Just incorporating this into a
Lookup.ini, it would look something like this:

;Note

I

;Lines may wrap to fit the column here, however, I have
;highlighted those wrapped lines that must be entered as
;one continuous line in your Lookup.ini.

[AutoUpdate]
uSSN = uSSN
[uSSN]

Otherwise = &left(strtran(strtran(Contact2->uSSN, [-],

[D, [ 1, [D, 3)+[-]+substr(strtran(strtran(Contact2

->uSSN, [-1, [D, [ 1, [, 4, 2)+[-]+right(trim(strtran(
strtran(Contact2->uSSN, [-], [1), [ 1, [D), 4)

Overwrite = 1

So GoldMine is watching the uSSN field for a change, and,
if a change occurs, GoldMine is to process the instruction
set for uSSN. The instruction set for uSSN then begins to
parse out the Social Security Number not from the value in
the field, but from the field value after any dashes and
spaces entered into the value have been removed. That is
represented by: strtran(strtran(Contact2->uSSN, [-], [1), [

1. D).

Another way of handling this could have been to only parse
the value if there was no dash in the field, however, that
would have expossed us to a possible typo: 025-23 1234
which would have been formatted wrong.

% N

Vertical Marketing Inc.
presents

CRMGold.net

Simple, fast, reliable .NET web access to your
GoldMine database. 15 minutes learning time for
GoldMine users, 1-2 hours for non-users. No setup:
It uses your GoldMine setup files to self-configure.

iz

VERTICAL MARKETING INC.

Contact David Lee
at dlee@vermar.com
or 703-367-9571 X 2222

or www.salesteam.com

N\ J
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Article Helps Adjust
FrontRanges
Thinking

by

DJ Hunt

In the last issue I wrote about the new FrontRange policy
that was planned to be deployed on August 1st, and how it
would have sent a message to the Mom & Pop organizations
that FrontRange was abandoning them. Since that article
appeared in the August issue and the uproar ensued,
FrontRange has decided to reconsider its positioning.

Rumors are just that:

Hence, what I am writing about today may or may not be
true when the final mandate is handed down. The current
word of mouth is that there will be no GoldMine Standard
upgrade to GoldMine 7.0, and that only the GoldMine
Corporate Edition users will be allowed to upgrade to
GoldMine 7 with its new ADO bridge to the tables. The
GoldMine Standard Edition users will be permitted to
upgrade to GoldMine 6.8 which will continue to use the
BDE bridge to the dBase tables.

From the Newsgroups by Jason Wienert:

Further to yesterday. It is our understanding from Paul
Petersen that what DJ has stated will be the case.

1. No firebird for standard edition.
2. However he indicated that all the other improvements
will be included.

Personally, I feel that this is a much more palatable solution
for the Mom & Pop organizations, although I believe that
FrontRange should now discontinue the numbering system.
Possibly, instead of GoldMine 7, they could just use
GoldMine Corporate Edition, and, instead of GoldMine
6.8, they could just use GoldMine Standard Edition.
Eventually the two numbering systems will conflict if they
continue down this route unabated.

Yes, this does make the maintenance for the developers
more difficult. However, in that light, and to ease the
maintenance issue, the developers could switch easily to
the ADO bridge. After all, one of the reasons for the switch
was to allow other backends to be added to GoldMine.
dBase via ADO is no different then MSSQL, Firebird, VFP
and others. If FrontRange develops a nice generic bridge
between the GUI and the Database, it shouldn't matter
what the database type is.

All in all, I am glad to see that the consumer has been
heard by FrontRange, and that they are trying to come up
with a solution that is beneficial to both the consumer and
to FrontRange alike.
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Intermediate Corner

Report Writing for GoldMine

Part Three:
Creating Summary Formulas for Reports

by

Andrea Dominguez

In our last article, we started

=
our report by deciding how it W = :
would be sorted. For this \A (
example, we will keep our
sorting on userid ( for the

assumption that multiple

users can be accessed ), and we will create parameters for the
dates to be entered at runtime, instead of putting them into the
options tab.

So let’s open the report layout and create our date range
parameter. The fastest way for me is to simply right-click on the
report and left-click on Layout from the local menu.

Before you enter in the dates, you need to think about if you
wanted a range of dates, meaning that the end date is not
necessarily today or today will be the end date no matter the
start date.

We will be creating a start
date and using today and the

Fiekd Name end date. Place your cursor
[sTART_DATE in the section of Sort Header

1 and right-click. Then select

Field Type Dialog Fields Table / Create.

? Tex A window will appear asking

s g"“""‘ for a name of the new dialog

~ ouble ( a.k.a. parameter ). See

= LD‘::“ Figure 1. When creating a
name, you must make it

appear to be one word. So if

0K | Cancel | | youwanted your dialog to say

- “START DATE" it needs to
Figure 1 be entered as

START_DATE. Then select what type of dialog ( parameter )
that it needs to be. When you push the OK button, it will look
like nothing happened.

You must insert the filter to look at the dialog.

To enter the filter, push the button for report filter, icon

= shown left, and a window will appear. Push the filter button

and type your filter to look for the date entered in the dialog. We

must tell the report to say that the ContHist.OnDate shown,

needs to be the START_DATE and greater. So for this, we want
to select a data field, an operator and the dialog field.

( Continued on Page 7 )



( Continued from Page 6 )
So the expression entered should look like this:

Conthist->Ondate>=DLG->START_DATE

(*note — you can modify the dialog once you save it to change
the prompting text by right clicking on the report and going to
dialog / modify.)

Push the OK button to save this filter.

Now we are ready to create our formulas to count activities. For
summary counts, you do not want to place your formulas in the
details section of the report, you want to place them in either the
sort header or insert a sort footer and place them in there. If
you wanted to have a grand total of all calls made by all users,
then insert a report footer and place your calculation field in
there. To insert additional sections, place your cursor anywhere
on your report and right-click to display the local menu. A menu
will appear and then go to Insert | Section. The available
items for insertion will vary depending on how you set up your
sorting. Sometimes there will be many choices, and sometimes
only a few choices. Only a Sort 1 Footer will be necessary for
this type of report.

To create a counting formula is fairly simple. We will be using
ContHist.SRecType field to count activities. The reason for this is
that the SRecType is only 1 character. There is no mistaking the
activity.

Here is a breakdown of activities as contained in
ContHist.SRecType:

A = Appointment

C = Call (outgoing, incoming, plain ‘ol call)
O = Other Action

M = Email Sent

L = Letter (merge form)

T = Next Action

D = To-do

Let’s create a formula [l x|

field. Remember that
when you create a

. < Calculation Field Name
name for the field, it [COUNT_APPT
must be technically =
one word just like the
dialog. oK | Concal |
Then add:
Figure 2

.if.(conthist->srectype="A").then.1.else.0
Basically, what this means is that if the srectype is an “"A” then
count it as value of 1, if it is anything else, then count it as zero.

If you have not guessed yet, for phone calls, you would change
the “"A” to “C"” and so on.

Report Prompt

Enter Start Date

||
| oK I

Figure 3

Cancel

When you run your report, you will get prompted to enter your
date:

Remember to use switches when entering the date ( meaning
*/". So September 1, 2005 would be entered 9/1/2005 or 09/01/
2005)

And, if you didn’t pay close attention to the article, you would be
wondering why your test report says START_DATE and mine
says 'Enter Start Date’. To change the prompting text, place
your cursor on the report in layout and go to Dialog | Modify.
From there you can select your dialog ( parameter ) and change
the text.

This is how my example turned out:

Activity Summary
For: 09/01/05 To 09/07/05

USERID: ANDREA

Appointment. 2

Figure 4

I added labels for USERID, Appointment, For, To, and changed
the Page Header label by double clicking on it. To display the
start and end date, I inserted the Dialog START_DATE and just
copied the print date in the lower left corner and pasted it where
I wanted it and then changed the font by double clicking on it.

The Toolbar from the report designer, items listed left to right:

\‘fé;

I

Figure 5

INSERT FIELD: Insert field from database. Macros will have
combos of items, such as full address.

LABEL: Text labels that can be altered by double clicking on
them after inserted into the report. (USERID, Appointment,
For, To)

NEW SECTION: Insert a section (Sortl, Sort2, Footers)

INSERT PICTURE: Means to insert a picture — Bitmap only.

INSERT LINE: Draw a line on the report

INSERT FORMULA: Create calculation formulas such as counts.

SYSTEM FIELD: Insert Date, Time, page breaks

DIALOG FIELD: Insert a Dialog field into the report to display
(such as START_DATE)

One last thing to keep in mind with creating reports that
run from the GoldMine Report menu is placement. The
reason for this is how the different tables are accessed. A
report that looks at history, such as this one should be
placed in the group Contact Reports. Also, keep in mind
as mentioned in part 1 of this article, have some patience
when the report runs. Reports created in this writer read
every single record before it starts to print and hardware
environment plays a big part on speed.

With that said, happy reporting!
Editorial Note:

Andrea is probably best known for her Crystal Reports

development, however, she has worked many years with the
GoldMine Reporting Tools.
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Tips, Tricks & Things

Where am I?
by
Daniel K. Martin

GoldMine 6.7 Chijing!

Ship to Contact: Order Template:
. =l
Temns: Credit Card: Exp:
I DI | =l
Ship Via Ship By: Code: Ship Date:
| D ~ [»] [6r2872005 ]
Qty: Product: Price: Total:
[1 =] |TestProduct1 [»] [s00.00 |500.00
[2 =] |TestProduct 2 [»] [s00.00 [1000.00
o =] [0.00 [0.00
o= [»] o0 [0.00
Notes: %Tax W 75.00
Shipping: [1495 |
Total: 1583.95
0K | Cancel |

This dialog form exists within GoldMine today, but how can
it be displayed/used?

Daniel asked this question in our August issue, and although
we had many people who wanted to know the answer
before the October issue was release, none knew the
answer to the question.

I have to admit that I did release the information to many
users who just couldn’t wait. One of them being Stewart
Spratt, who, when told the answer, developed a little
application that could be installed on each workstation,
and run from the Lookup.ini.

So just what is the answer? GoldMine had developed this
Sales Order dialog form way back when, but never gave
the GoldMine user the ability to change the Cal.RecType to
“I" which exposes this dialog form. If you create a Forecast
Sale and save it. Then change the RecType from “S” to
“I", and then edit the activity, this is the dialog form that
will be displayed. In fact, under the Pending tab the
Activity will have changed from Sale to Order.

Of course we all know that this can't be done within the
GoldMine environment, and not everyone has, or knows
how to use GoldBox, so Stewart has taken it upon himself
to write an application to do it for you. You may download
his application from:

http://www.dj-hunt.com/Download.htm

The Login and Password are case sensitive:
Login: Sales
Password: Order

8 The GoldMine Advisor- October 2005

Click on the Hummingbirds after you log in. You should
install this on each workstation that will be using the
application. You also want to install the application in a
folder under GoldMine on the Server.

Then, to launch the application automatically, you would
want to modify your Lookup.ini similar to this:

[ONNEWRUN]
Cal-S = Y:\GoldMine\Sales Order\Stol.exe
DisableFromAP = 1

Where Cal-S = would be the fully qualified path to
Stol.exe on your Server.

Let’s test it. Start GoldMine, and create a macro to create
a new Forecasted Sale..., and close it immediately. If
your Lookup.ini is working correctly, Stewarts application
should ask you: "Would you like to convert this Sale
into and Order?”, and all you have to do is click “Yes" to
accomplish this.

Now edit the new activity “Order”. Chijing!

Pitfalls in Stacking “;%
Multiple Values in a —u
Single Field

A |
by E

David Lee

Many GoldMine designers have discovered that they can
"stack" multiple values in a field by adding a semi-colon
(";") at the end of the text in the lookup window. This
changes the logic so that the value is added to the text
already in the field instead of replacing the text in the field.
(for purists, it adds a comma and space to existing text,
then the new text).

Here is a pitfall to avoid. I have seen it so often that I
know it is a common mistake:

Do not stack data into indexed fields such as the keyl
through keys5 fields (lower right quadrant in the top half of
the contact screen).

These fields are very valuable because you can quickly
find data through an indexed search. If you stack multiple
values, then you can no longer depend on an indexed
search, but must instead use "contains" logic. This is a
slow search and defeats the value of the index.

Instead, use the user defined fields under the Fields tab
for stacking multiple values. Stay tuned next time for some
tips on how to take advantage of any key fields that you
freed up.



Tips, Tricks & Things

Taskbar Icon to Open

—
an E-mail Populated ‘—gi%
” 22

Kevin Day

I figured out a way to add buttons on the taskbar that will
open a new email message with content filled in based on
a template. Quite handy if you do a lot of the same two or
3 emails.

Here are the keystrokes for recording the macro:

Alt - S - G (Open new GM email)

Alt+J (takes you to the subject line)

Shift+F4 (causes the template list to drop down)

Type Spacebar Public: Spacebar (then enough of your
template name to be unique)

Hit Down Arrow

Hit Enter

Hit Ctrl+Shift+End (to end the macro recording)

You can then add the resultant macro to a toolbar or the
taskbar. The only draw-
back to this is that the
subject line is fully selected
at the end of the macro (b/
¢ GM is silly and actually
records and plays back the
Ctrl+Shift+End sequence).
You could technically tab to
get to the message body,
but the entire body will get
selected by the Ctrl+Shift+End, so...

Editorial Note:

Although I don’t often

recommend this, to avoid the
Ctrl+Shift+End pitfall, click the
Stop macro recording button with
the mouse.

As a final FYI, I have successfully edited the macro files
with a hex editor and removed the Ctrl+Shift+End
keystroke. If you have a macro that's got to end cleanly
(without that key combo getting issued), you can do it.

Comment hy S
by ‘
Anonymous E

As you may imagine, I'm quite concerned about what's
going on at FrontRange right now - have you started
evaluating alternative CRM providers? For the money
FrontRange is charging for their Corporate Edition, the
Microsoft CRM is starting to
look like a viable option...

Editorial Note:

Unfortunately a lot of developers

agree with this. Why should a
developer be required to pay to
enhance the GoldMine product.

I can't stand 'em, but I'll
be damned if I'm going to
pay a company money for
the privelege of integrating
with them.

The Drill Down for

—
Filters "—_gi%
" 22

Gene Marks

What is the Drill Down button used for when creating filters?

The Drill Down button is used to combine filters and
potentially save the Drill Down results as new filters. To
use the Drill Down feature:

Open Lookup > Filters

Click New and type Key4 Filter

Click the Build tab

Select Key4 is equal to and choose a value
Click Insert Condition and click OK to save
Click New and type Zip Filter

Click the Build tab

Select Zip is equal to and choose a value
Click Insert Condition and click OK to save

To invoke the Drill Down:

Highlight the Key4 filter and click the Preview tab
Then click the Search All button

Go back to the Filters tab

Highlight the Zip filter and click the Preview tab
Then click the Drill Down button

The filter results will be combined to show Key4 contacts
that also meet the Zip filter criteria. This will create a
combined expression that can be saved as a new filter
(e.g. Key4/Zip filter) by clicking the Saye button in the
Preview tab.

Selecting All Contacts *}‘;ﬁ
With Pending Calls "_‘

i A2

Gene Marks

How would I select all contacts with pending calls to be
added to a group?

Right-click in the Groups window

Select New...

Give the Group a hame such as Pending Calls

Next screen, select Scheduled Calendar Activities

Click Next > and select the User, Erom/To Date
and Activity Type of Call Backs

Click Next > and select a Sort field if desired, leave
the Reference field as the default

Click Next > and the Finish

The GoldMine Advisor- October 2005 9



This Issues Major Contributors

Your Editor GoldSync Problems - A WHite Paper

| - Computerese ~ = Vertical Marketing, Inc.
1
DJ Hunt 'David Lee
GoldMine Technical Support President

* 152 Pratt Road

" 10021 Balls Ford Road
Fitchburg, MA 01420

2nd Floor

USA Manassas,VA 20109
USA P K
(978)342-3333 (703)367-9571
DJ.Hunt@DJ-Hunt.com : DLee@VerMar.com
http://www.DJ-Hunt.com http://www.VerMar.com

Sales Order

Report Writing for GoldMine

| - TSI Technology Group, Inc.

Andrea Dominguez
Technical Product Manager

' Stewart Spratt
CRM Consultant

" 632 North Craig Place
Addison, IL 60101
USA

' 1434 Mishawaka Avenue
South Bend, IN 46615
USA

(574)289-5733
Stewarts@TSITech.com
http://www.TSITech.com

(630)519-3967
Andrea.Dominguez@Comcast.net i

GoldMine MAPI Made Possible To Drill Down for Filters

Trumpet Inc. * ~ The Marks Group PC

Kevm Basso
Development Manager

' Gene Marks

: 45 E. City Avenue
3220 South Fair Lane :

Suite 342
Tempe, AZ 85282 Bala Cynwyd, PA 19004
USA USA

(602)438-7030
KevinB@TrumpetInc.com
http://www.TrumpetInc.com

(888)224-0649
http://www.MarksGroup.net
http://www.MarksGroup.net

Contributors Needed

The GoldMine Advisor cannot exist as a one person show. I do not mind publishing the newsletter for the
GoldMine community, but I must have articles to publish. Be you an enduser with a tip, or a 3rd party add-on
developer who would like to expose their product to the GoldMine community, or a GoldMine dealer with a great
article or story, please send in your articles today for the December issue of The GoldMine Advisor.

Let's try to keep this newsletter going strong, and this can only be done with your help. Send your articles, stories
and tips to:

DJ.Hunt@DJ-Hunt.com
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